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Prerequisites 
This document assumes that you are familiar with the use of a computer keyboard and 
mouse and have a working knowledge of Microsoft Windows 
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About this Document 

Words in bold 
Will need to be typed or chosen from a menu 
or window 

Small capitals – e.g. ALT Indicate keys that you press 

Press KEY1 + KEY2 Press both keys together 

Press KEY1, KEY2 Press each key consecutively 

Bulleted lists Are guidelines on how to perform a task 

Choose Insert - Picture 
Show menu commands – in this case, choose 
the option Picture from the Insert menu at 
the top of the screen 
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1 Introduction 
Objectives To introduce the main concepts and terms used in Excel 

Method  

  
 Excel is a spreadsheet, most useful for storing and processing numerical data, 

though you can store textual information should you want.  It is an extremely 
complex and powerful tool, but the main functions are fairly straightforward to 
pick up. 
 
Basic terms 
 
Workbook The file in which you store your data.  Can contain more than 

one worksheet – by default there are 3 in a workbook 
Worksheet The area you can see on screen, where you input data and 

perform calculations etc. 
Sheet tabs Appear at the bottom of the screen, 

allowing you to jump from one 
worksheet to another 

Cell Each box on the screen is known as a “cell”.  It is usually 
referred to by its address – e.g. A1 is the cell at the top left 
of the worksheet 

Active cell The cell that has a dark border around it is “active” – that is 
where anything you type will appear 

Row All the cells in one horizontal line, marked by the numbers on 
the left of the screen 

Column All the cells in one vertical line, marked by the letters at the 
top of the screen 

 
 

Activity 1.1 Open Microsoft Excel  
There may be an icon on your desktop, or you can find it on the Start menu 

Activity 1.2 Moving around in Excel 
You can move around a spreadsheet in a variety of ways.  Moving around the 
cells is (arguably) easiest with the arrow keys; 
 
←  left one cell 
↑ up one row 
→ right one cell 
↓ down one row 

Activity 1.3 Entering data 
If you want to enter information in a column, type in each value and press 
RETURN.  You will then be moved down to the next line. 
You may enter data in a row by using the TAB key to move across the 
spreadsheet. 

Column 

Active cell 

Row 
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You may also move around using the arrow keys 

Activity 1.4 Selecting areas with the keyboard 
Sometimes you may need a little more control over the area you select than 
clicking and dragging with the mouse will allow. 
 

To do so, you may use the keyboard. 
• Move to the first (top left) cell you wish to select 
• Hold down the SHIFT key (there are two, both have an upward arrow 

printed on them) 
• Use the arrow keys to increase the size of the area selected 
• Experiment by using the page up and page down keys.  The HOME key will 

move the selected area over to the first column 
• If you have data in your spreadsheet, pressing the END key followed by an 

arrow key takes you to the end of the data area 
• When you have finished selecting an area, let go of the SHIFT key 

 
Note: this also works in Word and other Windows applications 

Activity 1.5 Entering the same data into several cells 
• Select the cells into which you 

want to enter data  
• Enter one piece of data 
• Press CTRL+ENTER together 
• The cells are filled with whatever 

you just input 

 

 

2 Laying out a spreadsheet 
Objectives To produce a basic layout for a budget calculator 

Method We will use the drag handle and block selection method to enter data and text 

Comments  

  

Activity 2.1 Entering different data automatically 
We will set up a worksheet to act as a budget calculator. 
 
Excel will try to complete a series of data for you.  To tell it to do so, 
use the drag handle at the bottom right corner of the input box 
 

• Clear all data from your 
spreadsheet 

• Type the text  January 
into cell B1 

• Put the cursor over the handle – it will turn into a thin black 
cross 

• Drag the handle out to the right until all the months of the year
• what happens if you go beyond December? 
• If you drag too far, drag to the left to remove entries 

1 
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Excel also understands abbreviated forms of the months – Jan, Feb and so on. 
 
The same technique works for simple sequences of numbers, though you will 
need to enter and select more than one (e.g. enter 1 and 2 in separate cells, 
select the two and use the drag handle for excel to fill in 3,4,5…). 

Activity 2.2 Headings for Types of Expense 
Starting in cell A2, enter the headings shown in Figure  2-2 

 

Figure  2-2 

Activity 2.3 Repeat entries 
• Select the cells corresponding to Staffing for January to December – that 

should be B2 – M2 on your spreadsheet 
• Type in a value – e.g. 2500.45 
• Press CTRL + ENTER 

 
That value will be repeated across all the cells 
 

Activity 2.4 Using the drag handle to complete a sequence 
• Enter 10 and 12 in cells B3 and C3, as in Figure  2-3 
• Select both cells 
• Drag the drag handle across to the right to fill in the sequence across the 

row 
 
Because this is a simple sequence, Excel 
is able to add 2 to each value in order to 
continue it. 

 

Figure  2-3 
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Activity 2.5 Entering a block of data 
 
We now need to enter some information into the remaining cells 
 

• Enter 1, 2 and 4 in the cells next to “Materials” (which 
should be B4-D4) 

• Select the three cells 
• Right-click on the drag handle and drag it across to cell M4 
• A menu will pop up – choose Growth Trend, as shown in 

Figure  2-5 
 
Excel will continue the trend, doubling each value in the next cell 

Activity 2.6 Entering data into a block 
We will fill in random data for the remaining cells. 
 
You may do so by using the arrow or TAB keys to move around the w
there is another technique, allowing you to enter information in a blo
which will help. 
 
If you want to enter information in a block wider than one column yo
easiest to select the whole block using the mouse or keyboard. 
You may then enter information, pressing return after each value.  E
move you through the cells, and up to the top of the next column wh
the end of the current one. 
 
Figure  2-5 shows a selected block – the data shown has been entere
RETURN after each item 
 

• Enter some data in 
each of the remaining 
cells 

• Feel free to select a 
block and use 
CTRL+ENTER to fill in 
the same value 
across all cells – as in 
2.3, above 

Note: when you reach the last cell selected, pressing RETURN takes y
the first.  Be careful not to overtype the contents! 

Activity 2.7 Save your work 
 
Save the workbook to your n: drive – you may call it anything you li
include “wkshp” (without quotes) within the name to distinguish it fr
documents. 
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3 Calculations 
Objectives 

To set the worksheet up to perform calculations based on the data we have just 
input 

Method Use the autosum function to setup cells that perform calculations 

Comments  

  

Activity 3.1 Quick Sum 
You may quickly find out the sum of a group of values by 
selecting them using mouse or keyboard.  The sum of the 
selected area is displayed at the bottom of the screen (on a 
larger screen than that in the screenshot, it will be over to 
the right of the window). 
This is one advantage of pre-selecting the area to be filled, 
as in 2.5, above – the Sum will be updated as you fill in 
each field.   
 

• Select a few of the cells on your spreadsheet 
• Note the Sum, shown at the bottom-right of your screen 

Figure  3-1 

This is, of course, useful only for an immediate check of the total. 

Activity 3.2 Autosum 
You will most usually want the sum to remain on screen, as a part of the 
worksheet. 
 

• Click into the blank cell, A8, and add the word “Total” 
• Click into In the blank “Total” cell in column B (it should be B8) 

• Click on the Autosum icon   
 

Excel will guess which values you want to work with, and should have filled in the 
calculation =SUM(B2:B7) (note how Excel uses : to mean “to”) 
 

• Hit RETURN to confirm the calculation is correct 
 

• Repeat for C8 and D8 
 

Activity 3.3 Repeated Formulae 
 
Although we have done so here, it is not necessary to use the autosum button for 
each calculation.  Excel is clever enough to understand that if you copy and paste 
a “Sum” from one column, you want to work with the values in the new column.  
To see what I mean; 
 

• Click on D8 (which is the total of the values in column D) 
• Choose Edit – Copy   (or CTRL+C) 
• Click on E8 (which is blank at present) 
• Choose Edit – Paste   (or CTRL+V) 
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Figure  3-2 

Note – as in Figure  3-2 – that when you pasted in the formula,  Excel changed it 
from D2:D7 to E2:E7 

Activity 3.4 The drag handle 
 
We used the drag handle above to repeat values 
across a row.  It also works for formulae 
 

• Click on the drag handle in the total for row 
E 

• Drag it across until all the rows have their 
totals calculated 

 

Figure  3-3 

Excel will automatically update the totals - change some of the values to test it 
out. 
 
Have a look at the syntax of Excel formulae – note the = sign at the beginning, 
then the function to be performed, and finally, in brackets, the cells on which to 
perform it. 
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4 Amending the worksheet 
Objectives To add another expense to our budget 

Method Use the commands on the Insert menu to add to the worksheet 

Comments 
Excel will automatically update the calculations to take account of the inserted 
information 

  

Activity 4.1 
There are some other basic functions in excel we need to look at 
 
What if we wanted to add information in between the data we have already input?  
Excel will allow us to insert a column or row 

Activity 4.2 Inserting a row 
 

• Click into any cell in row 7 
• At the top of the screen, click Insert 
• Click Rows 

 

Figure  4-1 

A new row is inserted, and all those to the right of it are re-labelled 
You may insert columns similarly. 
 

• Click into any cell in column B 
• Click Insert 
• Click Columns 

 
A new column is inserted 
 
Note that, despite the commands referring to “columns” and “rows”, only one will 
be entered unless you have selected multiple rows or columns 

Activity 4.3 Deleting a Column 
We don’t need the column, so will remove it. 
 
The row and column labels at the edge of the worksheet – A,B,C; 1,2,3 etc – 
allow you to select a whole row or column.   
 

• Click on the label B 
 
The whole column is selected, as in Figure  4-2 
 

• Choose Edit – Delete 

Figure  4-2 

The column is removed 
 
Note that pressing the delete key will not remove the column, but will instead 
delete the contents of the cells 

Activity 4.4 Updated formulae 
Enter some information into the new, blank row of your spreadsheet 
 

• Type the text in 
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• Select all the blank cells in the row 
• Type a value 
• Press CTRL + ENTER to copy the value to all the other blank cells 

 

 

Figure  4-3 

Note that the rows containing the Total and Average calculations were 
automatically updated when the new row was inserted, and thus will now take 
account of the values just entered. 

 

5 Formatting the Worksheet 
Objectives To enhance the layout of the spreadsheet 

Method 
Use Excel’s Format-Cells command to control the layout and appearance of 
the cells within the worksheet 

Comments 
Many of the features of the Format-Cells popup may be accessed through 
individual icons on the toolbar – the popup is useful as it combines many 
different layout options in one place 

  

Activity 5.1 Sizing columns and rows 
Many of the items in the first column will not fit because they are wider than 
the column. To fix it 
 

• click on the A at the top of the column to select the entire column 
• Click on the Format menu and select column 
• a second menu appears 
• Select AutoFit Selection and the column width will expand to fit the 

widest cell.  
 
You may also manually scale the column.  
 
To do so it is not necessary to select the entire column first.  

 
• Position the mouse cursor so that it rests on the 

line between columns J and K 
• The cursor will change to a vertical bar with 

arrows pointing left and right 
• When it does, click and drag the column to the 

desired width 

Figure  5-1 

 
Finally (there are always several different ways of doing things!), you may 
use the “autofit selection” option without having to use the menus 
 

• Position the mouse cursor so that it is in between 
F and G 

• (again, it will change to a vertical bar with arrows 
pointing left and right when in the correct place) 

• Double click the left mouse button 
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• Column F is resized 

Figure  5-2 

For now, we will make all columns the same width 
 

Select all the columns from B to M (to select a full year); 

 

Figure  5-3 

• Click on the B at the top and hold the mouse button down 
• Drag the mouse across until all those columns are selected 
• Click on the Format menu 
• Choose Column – Width 
• Enter 9.5 and click OK (or press RETURN) 

Activity 5.2 Decimal places 
There are various styles that it would be sensible to apply to the data in our 
spreadsheet. 
 
We will make Excel show all values to two 
decimal places 
 

• Select all the cells with numbers in 

• Choose Format – Cells 
• On the Number tab, choose the 

category Number, with 2 Decimal 
places, as in Figure  5-4 

• Click OK 
 
 

Figure  5-4 
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Activity 5.3 Formatting the totals 
Because our spreadsheet is financial, it would be appropriate to show the £ 
symbol.  It would look a little too busy if added to every cell, however, so we 
will just apply it to the Total row 
 

• Select the row containing totals 
• Choose Format – Cells 
• On the Number tab, change the 

category to Currency 
 
We may apply other formatting whilst 
this dialogue box is up 
 

• Select the Border tab 
• Select a border style from the 

selection on the right hand side 
• Click into the preview window to 

add the selected border 

Figure  5-5 

You may also change the font size from this set of 
options.  Note that ###  displayed in a cell, as in 
Figure  5-6, denotes a column width too narrow for the 
information contained therein – widen the column to 
display the data.  

Figure  5-6 

• Click OK 
• Click away from the selected cells to see the effect of your changes 

Activity 5.4 Formatting the header row 
• Select the cells B1:M1 
• Use the toolbar icons to make the 

text bold and centred 

 
• Click and drag between the 1 and 

2 on the left hand side to expand 
the height of the row 

• Choose Format – Cells 
• On the Alignment tab, change the 

vertical alignment to “Center”, as 
in Figure  5-7 

 

Figure  5-7 

Note the other options on this tab, allowing you to orient text at a different 
angle, or to wrap text – useful if you have a lot of text to fit into one cell.  
Merge cells allows you to combine several cells into one – useful for titles and 
so on.  Select several cells and then click the icon  to merge and centre 
align them together. 
 

• Use the Patterns tab to apply a background colour to these cells 
• Use the Border tab to underline the title row 
• Click OK 

10 Bir
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6 Printing Options 
Objectives To change options for printing for best results 

Method 
Use the page setup command on the file menu to fit the spreadsheet to an A4 
page 

Comments 
It is possible to access page setup from within the print preview screen – 
click the “setup” button.  In normal usage you will probably need to switch 
between the two for best effect 

  

Activity 6.1 Page Setup 
 
There are several useful settings 
contained within the Page Setup 
dialogue. 
 

• Choose File – Page Setup 
• Change the Page 

orientation to Landscape 
 
The most useful setting is a little 
further down the dialogue box 
 

Figure  6-1 

• Click the radio button next to “Fit to” 
• Click OK 
• Choose File – Print Preview 

 
The spreadsheet is scaled to fit onto one page, which works well with our 
example, as it does not need to be reduced by much and is still legible.  With 
larger amounts of data, of course, there is the danger of creating a printout 
too small to read. 

Activity 6.2 Centreing the Data 
 

The options on the Margins tab 
allow you to change print 
margins, and also to centre your 
information on the page when 
printing. 
 

• Choose File – Page Setup 
• Click on the Margins tab 
• Tick the boxes under 

“Center on page”, as 
shown in Figure  6-2 

• Click OK 
• Choose File – Print Preview 

Figure  6-2 
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Activity 6.3 Further options 
 
The Sheet tab has further 
options which may be of 
use – the tickboxes under 
“Print” are fairly self-
explanatory. 
 
Printing gridlines may be 
useful to delineate your 
data, but for best results 
you should set borders 
using the techniques we 
have already explored 

 

 

Figure  6-3 

 

Activity 6.4 Headers and Footers 
 
Finally, you may apply a 
header to your printed 
document by using the 
Header/Footer tab. 
 

• Click on the 
Header/Footer tab 

• Click Custom Header 
• Enter text as 

appropriate, as in 
Figure  6-4 

• Click OK 
• Click Print Preview to 

see the effect 

Figure  6-4 

• Click Close 
 
 
 
 
 
 
 
 
 

Figure  6-5 

Adds filename 
and path (where 
it is saved) 

Use the icon to 
change text 
style and size 
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7 More calculations 
Objectives To include the calculation of VAT in our spreadsheet  

Method Include a function which multiplies an existing value by a constant 

Comments  

  

Activity 7.1 Calculating VAT 
• In the blank cell under “Total”, enter the text  VAT 
• Click into the first blank cell in the VAT row 

• Click on the Autosum icon   
• Click on the cell which contains the total for that column 

 
To multiply by a constant, we need only type the muliplication sign (note this 
is the asterisk - *) and the number to be used. 
 

• Type  *.175 
• Hit RETURN 
• Click Copy (shortcut CTRL+C) 
• Select the remaining cells in the row 
• Click Paste (shortcut CTRL+V) 

 
We saw above that selecting a block of cells allows us to repeat a value 
across them all.  As we have just seen, pasting a formula into a selected 
block allows quick replication of that calculation across rows or columns. 

Activity 7.2 Grand Total 
We now need a row to give the total including VAT 
 

• Change the text  Total  to  Subtotal 
• In the blank cell underneath “VAT”, enter 

the text  Total 
• Click into the empty Total cell of column B 
• Click on the autosum icon 

 
Note that even though Excel guesses which cell 
you want to sum, you do not have to accept its 
recommendation 
 

• Click and drag to select the Subtotal and 
VAT cells in column B (which should be 
B9 and B10) 

• Hit RETURN 
Figure  7-1 

Repeat the calculation across the whole row 
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8 Inserting a chart 
Objectives To insert a chart into our workbook 

Method 
Select the data to use, then use Excel’s chart wizard to choose the type and 
layout of the graph 

  

Activity 8.1 Selecting data for the chart 
Excel makes producing charts easy with the Chart 
Wizard.  We will look at how to insert a chart based 
on the data we select. 
 

• Select January’s expenses and the headings, 
as shown in Figure  8-1 

• Note that you may need to adjust the figure 
for staffing and others so that they are not 
too different from each other 

 

Figure  8-1 

Selecting the data tells Excel which information it should create a chart from 
 

• Click on the chart wizard icon  
 
The command is also available on the menus, as Insert – Chart 
 

Activity 8.2 Choose the Type of graph 
The first step in the chart wizard 
asks you to choose the type of 
chart. 
 

• Click Pie on the left 
• Choose a type of pie-chart 

on the right-hand side 
 
Note the button allowing you to see 
a sample of how your chart might 
look 
 

• Click Next 
 

Figure  8-2 

The next screen shows a sample of how the chart will look 
 

• Click Next again 

Activity 8.3 Options 
The next step of the wizard allows you to change various options relating to 
the chart, with the tabs at the top giving access to different areas. 
 

• Amend the chart’s title – note that the preview on the right-hand side 
also changes 
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• Click Next 
 
 
 
 
 
 
 
 
 
 

Figure  8-3 

Activity 8.4 Inserting the chart 
The final screen allows you to set where the chart will be inserted – into the 
current worksheet, or on its own, new worksheet. 
 

• Select “As new sheet” 
 
Once you have selected where to place the chart, the sheet name is selected; 
typing (you need not click anywhere) will therefore allow you to give that 
sheet a new name 
 
• Type a name for the new sheet, as in Figure  8-4 
 

 

Figure  8-4 

 
 

9 Sharing data  
Objectives To insert an Excel chart into a Word document 

Method Use copy and paste, then linked paste 

  

Activity 9.1 Basic copy and paste 
It is straightforward to copy the chart created in  8, above, into Word 
 

• Click anywhere on the outside of 
the chart – you will see black 
handles appear around the edge 
of the chart 

• Click the copy icon, or press 
CTRL+C 

• Start MS Word 
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• Choose paste – CTRL+V 
Figure  9-1 

Activity 9.2 The problem with basic copy and paste 
• Go back to Excel without closing Word (use the tabs at the bottom of 

the screen, or hold down the ALT key and press TAB to cycle through 
available windows) 

• Use the tabs within Excel to go back to your data 
• Change one of the values that appears in your chart 
• Have a look at the chart within Excel – that value has changed 
• Now go back to Word – the chart has not been changed 

 
While that is sometimes useful – in a report you might want the chart to be a 
snapshot of information at a certain time – it is possible to have the 
information update within Word 

Activity 9.3 Linked copy and paste 
• Copy the chart in Excel in the same way 
• Go back to Word 
• Click to place the cursor under the first chart  

(you may need to press return to create a 
new line – click to the right of the existing 
chart and then press return if so) 

• This time, choose Edit – Paste special (you 
may need to click the double arrow at the 
bottom of the menu to show it the first time) 

 

Figure  9-2 

• Select “Paste link” 

• As the text at the bottom of the 
window says, “changes to the source 
file will be reflected in your document” 

• Click OK 
 
Again the chart is inserted. 

Figure  9-3 

Now, though, when you go back to Excel and change a value, that change is 
represented both in Excel’s chart and Word’s (try it to check… - you may 
need to save and close the document in Word and then open it again to see 
the update) 
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